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Text Entry and Editing Basics
A blank document starts out with a flashing insertion point, which looks like a small vertical
bar. In addition, if you’re working in Draft or Outline view, a horizontal bar (not flashing)
appears as an end-of-file marker (see Figure 3.1). Initially the two markers are together
because there’s nothing in the file, but the end-of-file marker moves further down on the
page as you add more text to your document.

Figure 3.1
The insertion point is
a flashing vertical line;
the end-of-file marker
(appearing only in
Draft or Outline view)
is a horizontal, non-
flashing line.

End-of-file marker

Insertion point

➔ To switch between views, such as Draft and Print Layout, see “Switching Document Views,” p. 20.

Text you type always appears at the insertion point. (You can move it around, as you will
learn later in the chapter.) To enter text, just type as you would in any program. The follow-
ing keys have specific functions:

■ Enter—Press this key to start a new paragraph.

■ Shift+Enter—Press this key combination to start a new line within the same paragraph.

■ Ctrl+Enter—Press this key combination to start a new page.

■ Tab—Press this key to move to the next tab stop (by default every 0.5”).

■ Backspace—Press this key to delete a single character to the left of the insertion point.

■ Delete—Press this key to delete a single character to the right of the insertion point.

You can also delete a text selection of any size, including text and/or other objects, by press-
ing the Delete or Backspace key.

Line Breaks Versus Paragraph Breaks
A surprising number of people have trouble understanding the difference between a new paragraph and a new
line. Yes, starting a new paragraph does also start a new line, so on the surface they seem to be doing the same
thing. But if you turn on the Show/Hide ¶ feature (on the Home tab), you’ll see that two completely different
symbols are inserted.

A paragraph break (¶ symbol) creates a whole new paragraph, which can have its own indentation, bullets and
numbering, line spacing, and other paragraph-level settings.

A line break ( symbol) is like any other character of text within the paragraph, except instead of printing a let-
ter on the screen, it moves the insertion point to the next line. The text after the line break has the exact same
paragraph-level formatting as the text before the break, because it’s all one paragraph.
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Line breaks come in handy whenever you don’t want the stylistic attributes of multiple paragraphs. For example,
suppose you want to create a bulleted list of mailing addresses, with each complete address as a separate bullet
point. If you press Enter between the lines of each address, each line will have its own bullet character, like this:

■ John Smith

■ 240 W. Main Street

■ Macon, IL 62544

By using line breaks instead, you can create a single bulleted item with multiple lines, like this:

■ John Smith
240 W. Main Street
Macon, IL 62544

Switching Between Insert and Overtype Modes
When editing text, Insert mode is on by default, meaning that any text you type to the left of
existing text will cause the existing text to scoot over to the right to make room for it. The
alternative, Overtype mode, types over any existing text to the right of the insertion point. 

To toggle between Insert and Overtype mode, follow these steps:

1. Choose Office, Word Options.

2. Click Advanced.

3. Under Editing Options, mark or clear the Use Overtype Mode check box.

4. Click OK.

C A U T I O N
You cannot change the status of the Use Overtype Mode check box when Track Changes
is enabled on the Review tab. Furthermore, even if the active document does not have
Track Changes enabled, you still cannot access that check box if any open document is
tracking changes. You can, however, change the overtype status in one of the non-
tracked open documents using one of the methods described next.

If you find yourself frequently switching between Insert and Overtype, you might want to
set up an easier method for performing the switch. There are two such methods available:
remapping the Insert key, and adding an Insert/Overtype indicator to the status bar.

By default, the Insert key works as a shortcut for the Paste command on the Home tab. If
you prefer, you can change its mapping so that it instead switches between Insert and
Overtype modes.

➔ To learn about using the Insert key as a pasting shortcut, see “Using Paste Options,” p. 76.

To make the Insert key toggle between Insert and Overtype views, follow these steps:

1. Choose Office, Word Options.

2. Click Advanced.
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3. Under Editing Options, mark the Use the Insert Key to Control Overtype Mode 
check box.

4. Click OK.

Now the Insert key functions as a toggle between Insert and Overtype modes. To make it
more obvious which mode you are in, you might want to turn on the Insert/Overtype mode
indicator on the status bar.

To add the indicator to the status bar:

1. Right-click the status bar.

2. Click to place a check mark next to Overtype. 

Insert (or Overtype) appears in the status bar. You can then click that word to toggle between
them. 

Undoing, Redoing, and Repeating
Whenever you make a mistake, such as accidentally deleting or overwriting something, you
can easily reverse it with Word’s Undo feature. To undo, press Ctrl+Z, or click the Undo
button on the Quick Access toolbar.

The Undo feature retains a list of actions you’ve recently taken, and you can undo any num-
ber of them. The effect is cumulative. In other words, you can undo, for example, the last 
five actions you took, but you can’t pick-and-choose among those five; you must undo the
intervening four in order to undo the fifth one. To undo multiple levels, repeat Ctrl+Z or
repeatedly click the Undo button on the Quick Access toolbar, or click the down arrow to the
right of the Undo button to open a menu and then select the actions to undo from that list.

After you have undone one or more actions, the Redo button becomes available on the Quick
Access toolbar. It reverses undo operations, and comes in handy when you accidentally undo
too much. Ctrl+Y is its keyboard shortcut. Figure 3.2 shows the Undo and Redo buttons.

Figure 3.2
The Undo button
undoes the last action
when clicked; it also
has a drop-down list
from which you can
choose to undo multi-
ple actions at once.

RedoUndo

The Repeat feature enables you to repeat an operation such as typing, formatting, inserting,
and so on. The Repeat button looks like a U-turn arrow, and appears in place of the Redo
button on the Quick Access toolbar, when available. Its shortcut is also Ctrl+Y; this works
because Repeat and Redo are not available at the same time (see Figure 3.3).
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Inserting Symbols and Special Characters
The computer keyboard is very limited in the characters it can produce, and people often
need other characters to produce typeset-quality documents. For example, the copyright (©)

and trademark (™) symbols are frequently used in business documents, and an attractively
typeset page uses em dashes (—) rather than two hyphens together (--) to represent dashes
in sentences.

Inserting Symbols with Keyboard Shortcuts or AutoCorrect

Some of the most popular symbols have keyboard shortcuts and/or AutoCorrect shortcuts.
AutoCorrect is a feature used most often for correcting common spelling errors, but it is
also useful for generating certain common symbols on the fly. To use an AutoCorrect short-
cut, type the text shown and press the spacebar once, and Word converts the shortcut text to
the specified symbol. Table 3.1 summarizes both the keyboard shortcuts and the
AutoCorrect entries for some common symbols.

Table 3.1 Keyboard and AutoCorrect Shortcuts for Symbols

Symbol Keyboard Shortcut AutoCorrect Shortcut

— (em dash) Ctrl+Alt+Num –
(minus sign on the numeric keypad)

– (en dash) Ctrl+Num –
(minus sign on the numeric keypad)

© (copyright) Ctrl+Alt+C (c)

® (registered Ctrl+Alt+R (r)
trademark)

™ (trademark) Ctrl+Alt+T (tm)

… (ellipsis) Ctrl+Alt+. (period) ...

‘ (single Ctrl+`,`
opening Hold down Ctrl and press the grave accent 
quote) key ( `) twice. It is above the Tab key.

’ (single Ctrl+’,’
closing quote) Hold down Ctrl and press the apostrophe 

key twice. It is to the left of the Enter key.

“ (double Ctrl+`,”
opening Hold down Ctrl and press the grave accent 
quote) key ( `) once, and then type a quotation mark.

Repeat

Figure 3.3
The Repeat button
makes it easy to
repeat the last action
you took.

continues
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Table 3.1 continued

Symbol Keyboard Shortcut AutoCorrect Shortcut

” (double Ctrl+’,”
closing quote) Hold down Ctrl and press the apostrophe 

key once, and then type a quotation mark.

(typographical None <—
left arrow)

(typographical None —>
right arrow

(thick None <==
typographical 
left arrow)

➔ (thick None ==>
typographical 
right arrow)

↔ (double- None <=>
headed arrow)

N O T E
The single and double quotation marks in Table 3.1 are typographical—that is, they differ
depending on whether they are at the beginning or end of the quoted phrase. This is dif-
ferent from the straight quotation marks and apostrophes that you can directly type from
the keyboard.

Notice that in Table 3.1, there are no AutoCorrect entries for the dashes and the quotation
marks. That’s because they’re not needed. Word automatically converts straight quotes to
typographical ones (Word calls these “smart quotes”) and two hyphens in a row to a dash. If
you don’t want that change to occur, using Undo (Ctrl+Z) immediately after Word makes
the change to reverse it. Undo also reverses any of the AutoCorrect conversions as well if
you catch them immediately after they occur.

➔ To disable an AutoCorrect entry, see “Automating Corrections with AutoCorrect,” p. 111.

➔ To learn how to disable the automatic conversion of straight quotes to smart quotes, or two hyphens to
a dash, see “Setting AutoFormat As You Type Options,” p. 183.

Inserting Symbols with the Symbol Dialog Box

Another way to insert a symbol is with the Symbol button on the Insert tab. Click Symbol to
open a drop-down list of some common symbols (see Figure 3.4). (This list has some overlap
with the ones in Table 3.1, but is not the same list. There are more math symbols here, for
example.)
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If the symbol you want doesn’t appear, click More Symbols to open the Symbol dialog box,
shown in Figure 3.5. From here you can select any character from any installed font, includ-
ing some of the alternative characters that don’t correspond to a keyboard key, such as 
letters with accent symbols over them.

Figure 3.4
Symbols can be
inserted from the
Symbol drop-down list
on the Insert tab.

Figure 3.5
The Symbol dialog box
can be used to insert
any character from
any font.

You can also find a symbol by its character code, which is a numeric identifier of a particular
symbol in a particular coding system. The two main coding systems are ASCII and Unicode.
ASCII is the older system, and characters can be identified using either decimal or hexadeci-
mal numbering in it. Unicode is the Windows standard for character identification, and it
uses only hex numbering. Select the desired coding system from the From drop-down list
and then type the character code in the Character Code box.

On the Special Characters tab of the dialog box are some of the most common typographi-
cal characters, along with reminders of their keyboard shortcuts. If you need to insert one of
these common characters, finding it on the Special Characters tab can be easier than trying
to wade through all the characters in a font for it.

T I P
For a wide choice of interesting and unique symbols, check out the Wingdings fonts,
which you can select from the Font drop-down menu.
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Automating Symbol Entry

To make it easier to insert the same symbol again later, you might want to set up an
AutoCorrect entry or a shortcut key combination for it.

To create an AutoCorrect entry, follow these steps:

1. From the Symbol dialog box, click the symbol for which you want to create the entry.

2. Click AutoCorrect. The AutoCorrect dialog box opens with a new entry already started.

3. Type the text that should represent the symbol. It is customary to enclose one or two
characters in parentheses for AutoCorrect symbol insertion, but this is not required. For
example, to create an entry for the ± sign, you might choose (+) as the text to enter (see
Figure 3.6).

4. Press Enter. The new entry appears on the list.

5. Click OK to return to the Symbol dialog box.

T I P
If you want a special character such as an accented letter or copyright symbol to blend in
smoothly with the rest of the paragraph, make sure (normal text) is selected from the
Font drop-down list in the Symbol dialog box. You won’t always be able to do this,
though, because not all symbols are available in all fonts. When you select symbols from
the Special Characters tab, they are automatically in the (normal text) font.

Figure 3.6
Add an AutoCorrect
entry for a symbol.

To assign a shortcut key combination to a symbol, follow these steps:

1. From the Symbol dialog box, click the symbol for which you want to create the short-
cut.

2. Click Shortcut Key. The Customize Keyboard dialog box appears.
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3. Click in the Press New Shortcut Key text box and then type the key combination you
want to use. If that key combination is currently assigned to something else, a Currently
Assigned To line will appear, as in Figure 3.7. (You can overwrite a default shortcut key
assignment if desired.)

4. By default, the change will be saved to the Normal.dotm template; if you want it saved
only to the open document, open the Save Changes In list and choose the document.

5. Click the Assign button.

6. Click Close to return to the Symbol dialog box.

Figure 3.7
Map a keyboard
shortcut to a symbol.

➔ To learn more about creating AutoCorrect entries, see “Automating Corrections with AutoCorrect,” 
p. 111.

Moving Around in a Document
In a short document, moving around is easy. You can use the keyboard’s arrow keys to move
the insertion point, or click the mouse to place the insertion point where you want it.

But when a document grows to several pages or more, those basic methods can be insuffi-
cient. In the following sections, you’ll learn some shortcuts and alternative methods for
moving around in a document.

Scrolling
Vertical and horizontal scroll bars are available at the right and bottom of the Word win-
dow, respectively, whenever there is more content than will fit in the window. You’re proba-
bly already familiar with these from other applications, but here’s a quick review:

■ Arrows—Click an arrow to scroll a small amount in that direction, or click and hold on
an arrow to scroll quickly.
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■ Scroll box—This is the light part of the bar; drag it to scroll quickly without moving
through each page on the way there. The scroll box is context-sensitive; the more
undisplayed content, the smaller the bar will be. For example, if 50% of the document
appears onscreen and the other 50% is not shown, the scroll box will take up approxi-
mately 50% of the scroll bar.

■ Scroll bar—This is the dark part, behind the scroll box. Click above the scroll box to
move up one screenful, or click below the scroll box to move down one screenful.

Many mice and trackballs have a wheel between the left and right buttons. Roll this toward
you or away from you to scroll vertically in the document. Some of these wheels can also be
pushed to the left or right to scroll horizontally.

Moving the Insertion Point with Click and Type
The Click and Type feature enables you to place text anywhere on the page. If the location
you choose is outside the current document, extra tab stops and/or empty paragraphs are
added to allow the insertion point to reach that spot.

So what does “outside the current document” mean? Recall from the beginning of this chap-
ter that each document has an end-of-file marker, a small horizontal line that marks where
the last line of the document ends. This marker is visible only in Draft and Outline view, but
it’s always there, enforcing the boundary of the document. As you type lines of text, this
marker moves further down the page.

Before the days of Click and Type, you could not move the insertion point past this end-of-
file marker via normal methods (such as by pressing the arrow keys or by clicking). That
meant if you wanted to place text further down on the page than the end-of-file marker, you
had to press Enter, adding blank paragraphs, until the document had sufficiently expanded
so that the desired area was part of the document.

Click and Type provides an alternate method for placing text outside the document’s current
borders—and for starting text at horizontal locations other than the left margin. With Click and
Type, you simply double-click to place the insertion point, rather than the usual single-clicking.

If the location you chose is outside the end-of-file marker, Word automatically inserts the
needed blank paragraphs so that the area is within the document.

If the location you chose is not at the left margin, Word inserts a tab stop at the chosen spot
and tabs over to it for you. If the text you type is longer than will fit on one line, Word
wraps the next line to the left margin. To make all the text line up under the first line you
typed, select the paragraph and press Ctrl+Shift+T to create a hanging indent.

N O T E
If you find yourself accidentally enabling Click and Type when you don’t want it, turn 
the feature off. To do so, choose Office, Word Options, click Advanced, and in the Editing
Options section, clear the Enable Click and Type check box.
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You can even get different text alignments on those tab stops that Word creates with Click
and Type. Notice the mouse pointer changes as you move over different areas of the page.
When you are in an area where Click and Type can be used, the mouse pointer has a text
alignment symbol on it. Over the left side of the page, it’s a left-align symbol, as in Figure
3.8. In the center it’s a center-align symbol, and as you approach the right margin, it’s a
right-align symbol. Whatever symbol is shown when you double-click determines whether it
will be a left-aligned or right-aligned tab stop that’s created.

Figure 3.8
The tab stop’s align-
ment depends on the
area of the page in
which you are using
Click and Type.

➔ To change the tab stop’s alignment, see “Working with Tab Stops,” p. 201.

Navigating with Keyboard Shortcuts
Table 3.2 lists some keyboard shortcuts for moving the insertion point in Word 2007.

Table 3.2 Keyboard Shortcuts for Navigation

Keyboard Shortcut Moves to:

Alt+down arrow Next object

Alt+End End of the row

Alt+F1 (or F11) Next field

Alt+F6 Next window

Alt+F7 Next misspelled word

Alt+Home Start of the row

Alt+Page Down Bottom of the current column

Alt+Page Up Top of the current column

Alt+Shift+F1 (or Shift+F11) Previous field

Alt+Shift+F6 Previous window

Alt+up arrow Previous object

Ctrl+Alt+Page Down Bottom of the window

Ctrl+Alt+Page Up Top of the window

Ctrl+Alt+Z (or Shift+F5) Previous location of the insertion point

Ctrl+down arrow Next paragraph or next table cell

Ctrl+End End of the document

continues
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Table 3.2 continued

Keyboard Shortcut Moves to:

Ctrl+F6 (or Alt+F6) Next window

Ctrl+Home Beginning of the document

Ctrl+left arrow One word to the left

Ctrl+Page Down Next item (based on the Browse Object 
setting)

Ctrl+Page Up Previous item (based on the Browse Object 
setting)

Ctrl+right arrow One word to the right

Ctrl+Shift+F6 Previous window

Ctrl+up arrow Previous paragraph

End End of the current line

F6 Next pane or frame

Home Beginning of the current line

Page Down Next screen

Page Up Previous screen

Shift+F6 Previous pane or frame

Shift+Tab Previous cell in a table

Tab Next cell in a table, or starts a new table row if 
already in the last cell

Selecting Text and Other Objects
Like most applications, Word works using the selection/action system. First you select some
text or other data, and then you act upon that selection by issuing a command. For example,
first you select text to be copied, and then you issue the command to copy it.

There are many ways of selecting text and other objects in a Word document, and you can
use any combination of methods. However, some methods are much more convenient and
well-suited for certain situations.

The most basic way to select text with the mouse is to drag across the text (with the left
mouse button down). The selected text becomes highlighted.

By default, Word extends your selection to the nearest entire word, and includes the paragraph
marker at the end of a selected paragraph. If you do not want this, see “I Don’t Want Word to
Extend Selections” in the Troubleshooting section at the end of this chapter.
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There are also shortcuts for selecting certain objects or amounts of text with the mouse and
keyboard, as described in Tables 3.3 and 3.4, respectively. To use keyboard shortcuts, first
position the insertion point at the starting point for the selection and then use the keys indi-
cated to extend the selection.

Table 3.3 Mouse Shortcuts for Selecting

To select… Do This:

From the insertion point to any Position the insertion point, then hold down 
other point Shift and click the end point for the selection.

The entire document Triple-click in the left margin.

A word Double-click the word.

A sentence Ctrl+click the sentence.

A paragraph Triple-click the paragraph or double-click in the left 
margin next to it.

A line Click in the left margin next to it.

A table Click in the table and then click the Table Selection box 
(looks like a four-headed arrow) in the top-left corner of 
the table grid.

A table cell Click the left edge of the cell.

A table row Point the mouse pointer to the left of the row, so the 
pointer turns into a white arrow, and then click.

A table column Point the mouse pointer at the top gridline of the 
column, so the pointer turns into a black arrow, 
and then click.

A graphic Click the graphic.

A text box Click any outer edge of the text box.

A rectangular block (unrelated to Hold down Alt and drag across the area to select.
paragraph or column divisions)

Multiple noncontiguous selections Make the first selection and then hold down Ctrl as you 
drag across additional selections.

Multiple graphics or non-text objects Click the first object, and then hold down Ctrl as you 
click additional objects.

Table 3.4 Keyboard Shortcuts for Selecting

To select… Press This:

The entire document Ctrl+A

The bottom of the window Ctrl+Alt+Shift+Page Down

continues
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Table 3.4 continued

To select… Press This:

The top of the window Ctrl+Alt+Shift+Page Up

The end of the paragraph Ctrl+Shift+down arrow

The beginning of the paragraph Ctrl+Shift+up arrow

The end of the document Ctrl+Shift+End

The beginning of the document Ctrl+Shift+Home

A rectangular block (unrelated to Ctrl+Shift+F8+arrow keys
paragraph or column divisions)

The beginning of the word Ctrl+Shift+left arrow. Press the left arrow key again, 
still holding Ctrl+Shift, to extend to subsequent words.

The end of the word Ctrl+Shift+right arrow. Press the right arrow key again, 
still holding Ctrl+Shift, to extend to subsequent words.

The entire line above Shift+up arrow

The entire line below Shift+down arrow

The end of the line Shift+End

The beginning of the line Shift+Home

One character, line, or table cell in Shift+arrow keys
any direction

T I P
Here’s a trick you can do with the F8 key for selecting: Press F8 to turn Extend mode on,
and then press it again to select the current Word. Pressing it a third time selects the cur-
rent sentence, and pressing it a fourth time selects the entire document. You can also use
F8 with the arrow keys to extend the selection one character or line at a time in the
arrow’s direction. Use Shift+F8 to reduce the size of the selection. 

Moving and Copying Text and Objects
Perhaps the most important benefit of word processing over typewriter use is the ability to
move and copy objects and blocks of text. There are many ways of accomplishing move and
copy operations in Word, so you can select whatever method is most comfortable for you or
makes the most sense in a particular situation. The following sections explain the various
move and copy operations and the differences between them.
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Moving or Copying Text with Drag-and-Drop
Drag-and-drop operations are popular because they most closely resemble the way you do
things outside the computer. (Yes, there really is a life outside the computer!) When you
want to move something in your living room, you pick it up and reposition it. Or if it’s
heavy, like a piece of furniture, you drag it and drop it. You can do the same thing with
objects and with blocks of selected text in Word.

For a standard drag-and-drop operation, follow these steps:

1. Select the text or object(s) you want to move or copy.

2. (Optional) To copy, hold down the Ctrl key. You don’t have to hold anything down if
you want to move.

3. Position the mouse over the selection, and then click and hold down the left mouse but-
ton on it.

4. Still holding down the left mouse button, drag the selection to a new location. Then
release the mouse button.

There are additional drag-and-drop options; to see them, use the right mouse button rather
than the left one in the preceding steps. (Don’t hold down the Ctrl key if you are using the
right mouse button.) When you release the mouse button in step 4, a shortcut menu appears
with these choices on it:

■ Move Here—The default operation; the same as regular dragging with the left mouse
button.

■ Copy Here—The same as holding down the Ctrl key with the left-mouse-button drag.

■ Link Here—Creates a copy that retains a link to the original location, such that if the
original changes, this copy changes too.

■ Cancel—Cancels the current drag-and-drop operation.

Using Cut, Copy, and Paste
One of the complaints that many people have with drag-and-drop is that they are simply not
coordinated enough to manage positioning the mouse pointer in exactly the right spot while
holding down keys and mouse buttons. People who have this problem may prefer to use the
Cut, Copy, and Paste commands instead.

Cut and Copy are very similar operations. Cut removes the selection from the document
and places it on the Clipboard, which is a hidden holding area; Copy leaves the selection as
is and places a copy of it on the Clipboard. After a Cut or Copy operation, you can then use
Paste to place the Clipboard’s content at the insertion point location.
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Word offers ribbon, keyboard, and right-click methods for issuing the Cut, Copy, and Paste
commands. Table 3.5 summarizes them.

Table 3.5 Cut, Copy, and Paste Methods

Cut Copy Paste

Click these 
buttons on the 
Home tab:

Press these Ctrl+X Ctrl+C Ctrl+V
shortcut keys:

Right-click your Cut Copy Paste
selection and then 
choose one of 
these commands:

N O T E
There are actually two Clipboards—the Windows Clipboard and the Office Clipboard. The
Windows Clipboard holds only one item at a time; when you place a second item on that
Clipboard, the first item is erased from it. The Office Clipboard has multiple slots for
holding content. It uses the Windows Clipboard for one slot, but it can also hold 23 other
items at the same time. I explain more about the Office Clipboard later in the chapter.

T I P
Experienced users generally end up using the keyboard shortcut methods most fre-
quently because they are the fastest.

If you would like to save something from the Clipboard so that it can be used later, but you don’t
want to save it in Word, see “I’d Like to Save Clipboard Content for Later Use” in the
Troubleshooting section at the end of this chapter.

Pasting with Paste Special
The Paste Special command enables you to define the format of the pasted copy, and in
some circumstances also create a dynamic link to the original.

To use Paste Special instead of Paste, open the drop-down menu below the Paste button and
select Paste Special from that menu, as in Figure 3.9.

Doing so opens the Paste Special dialog box, shown in Figure 3.10.
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Figure 3.9
Select Paste Special
from the Paste but-
ton’s options.

Figure 3.10
Use the Paste Special
dialog box to paste in
a different way than
the default.

For a normal (nonlinked) paste, select a paste format from the As list. The choices on the
list depend on the type of content you cut or copied. For example, if you copied some text
from another document that had some unusual formatting, you could choose to keep that
formatting by selecting Formatted Text (RTF), or you could choose to discard that format-
ting by selecting Unformatted Text.

C A U T I O N
If you paste text in one of the Picture formats, it is no longer editable as text; you can
edit it only with a picture-editing program.

Pasting in a format whose name ends with “Object” creates an embedded copy that retains
its link to the original program. This is not especially relevant for copying text within and
between Word documents because the original program is Word itself, but it makes a differ-
ence when copying multimedia content, such as graphics from a graphics program, into
Word, for example. When you choose an “Object” format, the selection is placed in its own
separate frame from the rest of the document, and you can edit that object in its native pro-
gram later by double-clicking it.

Under some circumstances, a Paste Link option is also available. For Paste Link to be avail-
able, the selection must have been copied from some other document or file than the one in
which it is being pasted, and the document/file from which it came must have been saved at
least once (so it has a filename, not just the generic “Document1” name a file gets before it
is saved). Paste Link creates a dynamic link between the original and the copy so that when
the original changes, the copy also changes.
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C A U T I O N
Don’t use Paste Link unless you can actually benefit from it, because it makes the file size
larger, and if the original file ever is deleted or moved, an error message will appear in
the file containing the copy.

➔ To learn more about linking and embedding, see “Embedding Data,” p. 615 and “Linking to Data in
Other Files,” p. 620.

Using Paste Options
After you have pasted something in Word, a Paste Options button appears next to it. You
can click this button to open a menu of choices governing the paste operation, as shown in
Figure 3.11. Here are the choices:

■ Keep Source Formatting—The object retains its look from its original location.

■ Match Destination Formatting—The object is stripped of any previous formatting
and the formatting of the new location is applied.

■ Keep Text Only—The object is stripped of any previous formatting and remains
stripped in the new location.

Figure 3.11
Choose options for
the paste operation
just performed.

The Set Default Paste command opens the Word Options dialog box (same as Office, Word
Options) and displays the Advanced options. From here you can set a variety of paste options
in the Cut, Copy, and Paste section, as shown in Figure 3.12:

Figure 3.12
Paste options are con-
trolled in the Word
Options dialog box.
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■ Pasting Within the Same Document—Choose how formatting is applied to the copy
when copying within a document. You can choose Keep Source Formatting, Match
Destination Formatting, or Keep Text Only.

■ Pasting Between Documents—Choose how formatting is applied to the copy when
styles are not an issue (for example, when both the source and destination use the same
style defined the same way).

■ Pasting Between Documents When Style Definitions Conflict—Choose how for-
matting is applied to the copy when you are copying between documents and the style
applied in the source document differs from that applied at the insertion point location
in the destination document.

■ Pasting From Other Programs—Choose how formatting is applied to the copy when
the text is coming from some other application than Word.

■ Insert/Paste Pictures As—Choose how non-text objects are placed in the document.
In Line with Text means the object is treated as a text character at the insertion point,
and will move with the surrounding text. The other options are all various wrapping
settings for floating objects.

➔ For more on picture/text wrap settings, see “Setting Text Wrap Properties,” p. 402.

■ Keep Bullets and Numbers When Pasting Text with Keep Text Only Option—
Just like the name says. If you have set one of the previous settings to Keep Text Only,
but you are copying a bulleted or numbered list, this setting determines whether the
bullet or number is preserved.

■ Use the Insert key for Paste—Mark this if you want the Insert (Ins) key on the key-
board to be remapped to be a shortcut for the Paste command. This check box is paired
with the Use the INS Key to Control Overtype Mode check box (on the same tab);
only one or the other can be chosen at once.

■ Show Paste Options Buttons—Clear this check box if you don’t want that Paste
Options button to appear next to pasted selections. (Sometimes it can get in the way.)

■ Use Smart Cut and Paste—Enables Word to apply a rather complex set of rules to deter-
mine how selections should be pasted. To fine-tune these rules, click the Settings button to
display the Settings dialog box (see Figure 3.13). Note that you can choose default options
for Word 2002-2007 or for Word 97-2000, or go your own way with custom settings.

Figure 3.13
Fine-tune the paste
options here.
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Each time you copy something to the Clipboard, it is added to the Clipboard task pane’s list,
with the most recently added items at the top. To paste an item from it, position the inser-
tion point and then click that item in the Clipboard task pane. To paste all the items at once,
click Paste All.

Using the Office Clipboard
The Office Clipboard is an expanded version of the Windows Clipboard. It can hold up to
24 selections, and you can choose which item to paste with each operation.

N O T E
If you are copying or cutting between an Office application and a non-Office application,
the two Clipboards talk to each other, but only via the first position on the Office
Clipboard. The other 23 possible positions on the Office Clipboard are simply ignored.

To access any clips other than the last one stored, you must display the Office Clipboard task
pane. To view the Office Clipboard task pane, click the dialog box launcher for the
Clipboard group on the Home tab.

The Office Clipboard appears to the left of the main document window, as shown in 
Figure 3.14.

Figure 3.14
Use the Clipboard task
pane to access the
Office Clipboard’s 24
separate areas for
storing clips.

N O T E
By default, the Clipboard pane is fixed in location and size, but you can click the down
arrow in its top-right corner for a menu from which you can move and resize it.



79Locating Specific Content

3

Figure 3.15
Delete an item from
the Clipboard.

To clear the entire Clipboard at once, click the Clear All button at the top. Clearing the
Office Clipboard also clears the Windows Clipboard.

To fine-tune how the Office Clipboard works, click the Options button. A menu appears
with these options on it:

■ Show Office Clipboard Automatically—Displays the Office Clipboard automatically
when copying items.

■ Show Office Clipboard when Ctrl+C Pressed Twice—Displays the Office Clipboard
when Ctrl+C is pressed twice.

■ Collect Without Showing Office Clipboard—Copies items to the Office Clipboard
but does not show the task pane unless you specifically call for it (by pressing Ctrl+C
twice, for example).

■ Show Office Clipboard Icon on Taskbar—Displays an Office Clipboard icon in the
notification area of the taskbar (near the clock) whenever the Office Clipboard is active.
You can double-click that icon to display the Office Clipboard in the active application.
(Remember, all Office apps share the Office Clipboard.)

■ Show Status Near Taskbar When Copying—Pops up a message near the Office
Clipboard icon when something has just been copied to the Clipboard.

Locating Specific Content
Word offers many ways of jumping quickly to certain content in a document. This content
can be actual data that you’ve typed, or can be an object such as an image, a caption, a book-
mark, or even a certain type of formatting. In the following sections, you’ll learn about sev-
eral ways to browse or search a document to find specific items.

Finding and Replacing
The Find feature in Word helps locate instances of a specified text string. That text string
can be anything you care to look for—a product name, a person, a string of numbers, or
whatever. You can even use it to find specific formatting or a nonprinting symbol or code,

To remove a single item from the Clipboard task pane, right-click the item and click Delete
(see Figure 3.15). (Alternatively, you can point at the item until a down arrow appears to its
right. Click that down arrow to open the same menu as with right-clicking; then click
Delete.) 
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such as a tab or a paragraph break. For example, suppose you are looking for a phone num-
ber in a document. You don’t remember what page it’s on, but you know it starts with a
(317) area code. You could search for (317) to locate it.

The Replace feature works hand-in-hand with Find; it performs the Find operation but then
replaces the found item with a different text string you specify. As with Find, you can also
use Replace with formatting and with nonprinting symbols and codes. For example, suppose
you are drawing up a contract for a Ms. Smith, when you find out that she has recently
become Mrs. Brown. You can perform a Replace operation to change all instances of Smith
to Brown, and all instances of Ms. to Mrs. (Be careful with that one, though, because there
might be more than one person in the document who uses Ms. as a prefix.)

Finding a Text String

Here’s how to do a basic Find in which you examine each instance of the text, one instance
at a time:

1. Press Ctrl+F, or click Find on the Home tab.

T I P
If you use Find frequently, consider adding a button for it to the Quick Access toolbar. To
do this, right-click the Find button on the Home tab and choose Add to Quick Access
Toolbar. That way you can access it no matter which tab is currently displayed.

2. Type the text string into the Find What box. (To find other things besides text strings,
such as special characters or formatting, see the next several sections.)

3. Click Find Next. The display jumps to the first instance of that text (see Figure 3.16).

4. Keep clicking Find Next until you find the instance you are interested in, or until a
message appears that Word has finished searching the document.

Figure 3.16
Find a text string in a
document.

Selecting All Instances of Found Text

If you prefer, you can have Word select all instances at once, and then you can page through
the document to examine them. This method actually selects the text strings, as if you had
held down Ctrl and dragged across them to select them yourself with the mouse. Clicking
anywhere in the document will deselect them, so you can’t do any editing of individual
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instances here without disturbing the selection. However, what you can do is perform some
global formatting command upon them all, such as making them all bold or a different font
or color.

To select all instances of the found text, follow these steps:

1. Press Ctrl+F, or click Find on the Home tab.

2. Type the text string into the Find What box.

3. Click Find In. On the menu that opens, click Main Document. Word selects each
instance of the text string.

4. Without closing the Find and Replace dialog box, scroll through the document to
examine all the instances. If desired, apply a formatting command to them as a group.

➔ To learn more about text formatting, see “Applying Character Formatting,” p. 155.

5. When you are finished, click Close to close the Find and Replace dialog box.

Highlighting All Instances of Found Text

The preceding procedure selects the instances only for as long as the Find and Replace dia-
log box is open and you have not clicked to select anything else. Their selection is pretty
tenuous, in other words. If you want more durable marking of each found instance, try this
instead:

1. Press Ctrl+F, or click Find on the Home tab.

2. Type the text string into the Find What box.

3. Click Reading Highlight. On the menu that opens, click Highlight All.

4. Close the Find and Replace dialog box and examine all the found instances at your
leisure.

5. When you are finished examining all the found instances, reopen the Find and Replace
dialog box (Ctrl+F).

6. Click Reading Highlight. On the menu that opens, click Clear Highlighting. This
clears the highlighting applied from the Find and Replace dialog box, but does not clear
highlighting applied with the Highlight feature on the Home tab.

7. Close the Find and Replace dialog box.

Customizing a Find Operation

The Find operation has many options available for customizing the search. To access them,
click the More >> button in the Find and Replace dialog box. The dialog box that appears is
shown in Figure 3.17.
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Figure 3.17
Customize the Find
command using these
search options.

You can set any of these options as needed:

■ Search—Choose Down, Up, or All to determine in what direction from the insertion
point the Find operation will proceed.

■ Match Case—The search is limited to the letter case you used for typing the Find
What entry. For example, if you are searching for butter, it will not find Butter.

■ Find Whole Words Only—The search is limited to whole words that match the search
string. For example, if you are searching for butter, it would not find butterfly.

■ Use Wildcards—You can use wildcard designators in your searches to find any charac-
ter (^?), any digit (^#), or any letter (^$). If you forget these codes, you can select them
from the Special menu.

■ Sounds Like (English)—The search will include words that are pronounced similarly
to the word you are searching for. This is good to have if you aren’t sure how to spell a
word but you know how it sounds.

■ Find All Word Forms (English)—The search will contain forms of a word even if they
are not spelled the same. For example, a search for is would find words such as am, is,
are, was, were, and be.

■ Match Prefix—Finds the string only if it appears at the beginning of a word.

■ Match Suffix—Finds the string only if it appears at the end of a word.

■ Ignore Punctuation Characters—Omits punctuation from the search. For example, a
search for three and would find three, and (note the comma) if this option is turned on.

■ Ignore White-Space Characters—Omits white space from the search. For example, a
search for living room would find livingroom.

With all these options showing, the Find and Replace dialog box becomes rather large and
cumbersome. You can shrink it again by clicking the <<Less button.
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Replacing a Text String

Click the Replace tab in the Find and Replace dialog box for access to the Replace tools. If
the dialog box is not already open, you can open it and display that tab on top by pressing
Ctrl+H or selecting Replace on the Home tab.

After entering text in the Find What and Replace With boxes, click Find Next to find the
first instance of the string, and then click Replace to replace that instance, or click Find
Next again to skip that instance (see Figure 3.18).

Figure 3.18
Replace one text string
with another on the
Replace tab.

If you’re really brave, click Replace All to do all instances at once. Be aware, though, that
this can have unintended consequences if there are instances you didn’t anticipate. For
example, suppose you are replacing all instances of White with Brown. But somewhere in
your document you talk about the whitening power of a laundry product. The word whiten-
ing would become brownning, which is clearly not what you want.

Finding and Replacing Formatting

In addition to finding text strings, Find and Replace can also find formatting. You can use
this to find certain strings that are formatted in a certain way, or you can simply find the for-
matting itself and not include any text in the search.

To find (and optionally replace) certain formatting, follow these steps:

1. Make sure the additional controls are displayed in the Find and Replace dialog box.
Click the More >> button to display them if they are not.

2. Click in the Find What box to place the insertion point in it. (Optional) If you want to
limit the search to certain text, type that text.

3. Click the Format button. A menu opens.

4. Click the type of formatting you want to specify. For example, to specify character for-
matting such as a font, click Font.

5. In the dialog box that appears, specify the formatting you want to find and then click
OK. The dialog box will be different depending on the type of formatting you chose in
step 4. For example, in Figure 3.19, the Find Font dialog box is shown.

Notice that the Effects check boxes have a solid fill in them, meaning that their setting
will not be an issue in the search. If you click one of them, it becomes selected with a
check mark, meaning the search will find text only with that attribute on. Click it again
and it becomes cleared, meaning the search will find text only with that attribute off.
Click it a third time to cycle back to the solid fill again.
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Figure 3.19
Find Font is just one
example of the dialog
boxes for specifying
formatting to find.

N O T E
If you make a mistake in specifying formatting, click in either the Find What or the
Replace With text box and click No Formatting to clear it.

Back in the Find and Replace dialog box, a line now appears beneath the Find What
text box stating the formatting that has been chosen.

6. (Optional) Repeat steps 3–5 to specify more formatting criteria for the text to be found.

7. (Optional) If you want to specify formatting for the replacement, click in the Replace
With box and then repeat steps 3–5.

8. Continue the find operation normally. You can use the Find Next button for an interac-
tive find, or use Replace, Replace All, Find In, or Reading Highlight. (The latter two are
available only on the Find tab.)

Finding and Replacing Special Characters

Sometimes the text you need to find is not really text at all, but a layout character such as a
paragraph break, page break, or tab. It’s actually a fairly common need. For example, suppose
you download some unformatted text from the Internet in a plain-text file that uses two
paragraph breaks per paragraph—one to end a paragraph and one to create an extra line
break between paragraphs. You want to get rid of the extra paragraph breaks, but it’s a 100-
page document. No problem. For the Find What field, enter two paragraph breaks by select-
ing Paragraph Mark from the Special menu twice in a row. In the Replace With box, enter a
single paragraph mark. In other words, you’re replacing every instance of two paragraph
marks with one paragraph mark.
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As you select a symbol from the Special menu, a caret code is entered into the Find What or
Replace With box. It’s called a caret code because each of these codes begins with a caret (^)
symbol. If you happen to remember the code for what you want, feel free to type it in man-
ually. Table 3.6 lists the codes for all the available special characters. Some of these are avail-
able only to find, not to replace, so they will not be available on the list when the insertion
point is in the Replace With box.

Table 3.6 Caret Codes for Special Characters in Find and Replace Operations

Symbol Code Where Available

Paragraph break ^p Find What/Replace With

Tab character ^t Find What/Replace With

Any character ^? Find What

Any digit ^# Find What

Any letter ^$ Find What

Caret character ^^ Find What/Replace With

Section character (§) ^% Find What/Replace With
(not an actual section break)

Paragraph character (¶, not an ^v Find What/Replace With
actual paragraph break)

Clipboard contents ^c Replace With

Column break ^n Find What/Replace With

Em dash (—) ^+ Find What/Replace With

En dash (–) ^= Find What/Replace With

Endnote mark ^e Find What

Field ^d Find What

Find What text ^& Replace With

Footnote mark ^f Find What

Graphic ^g Find What

Manual (hard) line break ^l Find What/Replace With

Manual (hard) page break ^m Find What/Replace With

Nonbreaking hyphen ^~ Find What/Replace With

Nonbreaking space ^s Find What/Replace With

Optional hyphen ^- Find What/Replace With

Section break ^b Find What

White space ^w Find What
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In addition to the “caret codes” that refer to individual symbols, there are a variety of special
codes that can refer to multiple characters. Table 3.7 lists the available codes and their usage.

Table 3.7 Text String Codes for Find and Replace Operations

To find… Use This: Example

Text at the beginning of a word < <(new) finds newton but not renew; 
same as match Prefix.

Text at the end of a word > >(new) finds renew but not newton; same
as Match Suffix.

Any single character of a list [ ] f[ai]n finds fan and fin but not fun
of characters 

Any single character in a range [-] s[a-o]ng finds sang, sing, and song, but 
not sung.

Any single character except the [!] s[!a-o]ng finds sung but not sang, sing, 
specified character range or song

An exact number of occurrences of {n} we{2}d finds weed but not wed
the preceding character or expression

At least a number of occurrences of {n,} we{1,}d finds both weed and wed
the preceding character or expression

Any single character {n,m} 5{1,4} finds 50, 500, 5000, and 50000

One or more occurrences of the @ 50@ finds 50, 500, 5000, and higher 
preceding character or expression numbers of zeros

Using Select Browse Object
The Select Browse Object feature provides an efficient way to scroll through a document
when you are looking for a specific type of content. For example, suppose you want to scroll
through a large document so you can check the captions on the graphics. You could use
Select Browse Object to scroll to the graphics, skipping over any screens that don’t contain
graphics.

Start by clicking the Select Browse Object button, which is the round icon below the lower
arrow on the vertical scroll bar. (Alternatively, press Ctrl+Alt+Home.) A fly-out palette of
choices appears. You can point to each choice to see a description. (Table 3.8 also describes
each one.) Click one of the choices to specify what to browse for (see Figure 3.20).

Figure 3.20
Choose what Word
should browse for.
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After selecting the browse type, use the blue double arrows above and below the Select
Browse Object button (or press Ctrl+Page Down or Ctrl+Page Up) to move to the next or
previous instance of the chosen item.

Table 3.8 Select Browse Object Types

Button Object Type

Opens the Go To tab in the Find and Replace dialog box

Opens the Find tab in the Find and Replace dialog box

Browse by edits (if tracking changes)

Browse by heading

Browse by graphic

Browse by table

Browse by field

Browse by endnote

Browse by footnote

Browse by comment

Browse by section

Browse by page

Using Go To
Go To is useful when you want to go to a particular instance of a content type, not just
browse all instances. For example, perhaps you don’t want to go through the document page
by page, but instead want to jump immediately to page 100. Go To lets you enter the
desired page number and go to it. It does this not just with pages, but with many other types
of items as well, such as comments, bookmarks, graphics, and so on.

As you saw in Table 3.8, you can access the Go To tab of the Find and Replace dialog box
via the Select Browse Object feature. You can also access it by clicking Find and selecting
Go To on the Home tab (see Figure 3.21).

Figure 3.21
Select Go To on the
Home tab.
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On the Go To tab, select the item type and then enter the information about it. Depending
on the type of item, either a text box or a drop-down list appears. Figure 3.22 shows an
example of browsing for a particular section, for example.

Figure 3.22
Go to a specified
instance of a particu-
lar type of item with
the Go To tab.

Figure 3.23
Display a document
map that shows all the
headings and book-
marks.

➔ To learn about the other tabs of the Find and Replace dialog box, see “Finding and Replacing,” 
p. 79.

Displaying a Document Map
In a document that uses heading styles, you can display a document map that lists the head-
ings, like a mini-outline view. You can click a heading in the document map to jump quickly
to that heading within the document itself.

To display the document map, select the Document Map check box on the View tab. Then
click an item on the map to jump to it in the document.

You can customize the document map to show only certain heading levels if you wish. To do
so, right-click an empty area of the document map and click the desired outline level, as
shown in Figure 3.23. Alternatively, you can click a particular heading that has subheadings
beneath it and then right-click and choose Expand or Collapse to show more or fewer levels
in only a section of the outline.
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To turn off the document map, click the Close (X) button in the top-right corner, or clear
the Document Map check box on the View tab again to toggle the feature off.

➔ To learn about heading styles, see “Understanding Styles,” p. 228.

➔ To change the outline level at which a style appears in the document map, see “Setting a Style’s
Outline Level,” p. 688.

Displaying Page Thumbnails
Thumbnails are small images of each page. They are useful in situations where you want to
move to a certain page based on what it looks like. (Maybe it has a distinctive graphic on it,
for example.)

To display or hide page thumbnails, mark or clear the Thumbnails check box on the View
tab.  Or, if the document map is already open, use the drop-down list at the top of the docu-
ment map to switch to Thumbnails view.

Inserting Dummy Text
Dummy text is generic text that is inserted so you can see the document’s formatting. This
is especially useful when creating multicolumn frame-based layouts such as in a brochure or
newsletter.

Different applications use different words for dummy text; some programs repeat the same
sentence over and over, use nonsense words, or use Greek phrases. (The latter is an inside
joke born of the fact that in typesetting, when lines are placed where text will eventually go,
it’s called greeking, as in “It’s all Greek to me.”)

Word 2007, however, has real English language paragraphs that it uses, and they even make
sense! Word use three paragraphs with text that discusses the galleries feature. If you insert
more than three paragraphs, they start repeating.

To insert dummy text, you use a random function such as the following, where p represents
the desired number of paragraphs:

=rand(p)

You just type this directly into the document, and when you press Enter, Word replaces
what you typed with the paragraphs.

By default, each paragraph has three sentences in it. If you want more or fewer sentences
per paragraph, add another argument to the function, like this:

=rand(p,s)

Here, s is the desired number of sentences. For example, to get eight paragraphs with four
sentences each, use =rand(8,4).



Working with Building Blocks
Earlier versions of Word had a feature called AutoText that stored and retrieved snippets of
text. Word 2007 has greatly expanded this capability into a new feature called building blocks.
Building blocks are stored snippets that can contain formatted text, graphics, and other
objects. They can be inserted into any document at any time.

90 Chapter 3 Typing and Editing Text

3

N O T E
Word 2007 still nominally supports something called AutoText, in that one of the building
block galleries is named AutoText and you can place items into it. However, AutoText is
now part of the building block functionality.

Building blocks are categorized by their function and are organized in galleries. The gallery
in which a building block is stored is a matter of preference, but different galleries do show
up in different places in the program. For example, if you place a building block in the
Quick Parts category, it will appear on the Quick Parts drop-down list on the Insert tab.

Building blocks are stored in templates. To make a block accessible to all new documents
based on Normal.dotm, you can store it in that template. Alternatively, you can store a
building block in a template called Building Blocks.dotx, designed specifically for holding
them. The Building Blocks.dotx template is always available, no matter what template is
applied to the body of the document.

N O T E
The difference in file extensions between the two templates is part of Word 2007’s new
system of file naming. A .dotm template supports macros; a .dotx template does not.

Creating a Building Block
A building block can contain text (formatted or unformatted), graphics, objects such as text
frames, diagrams, or WordArt, and more. Anything you create in Word can be saved in a
building block.

To create a building block, first create the content and then do the following:

1. Select all the content that should be included in the document part.

2. On the Insert tab, choose Quick Parts, Save Selection to Quick Part Gallery. The
Create New Building Block dialog box opens (see Figure 3.24).

C A U T I O N
This function works only when it is typed as a paragraph all to itself. It doesn’t work
when typed as part of an existing paragraph, or at any position other than the beginning
of a paragraph.
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3. In the Name box, change the default name if desired. This name will appear on lists of
building blocks. By default, the name is the first few words of the text.

4. Change the Gallery setting if desired.

By default, the Gallery is set to Quick Parts. Items placed in this gallery will be accessi-
ble via the Quick Parts menu, so they’ll be very convenient. However, if you add too
many items to the Quick Parts gallery, it might become unwieldy to work with the list.
Various galleries are used for features you will learn about in other chapters throughout
the books, including headers and footers, page numbers, and cover pages.

5. (Optional) Assign a category to the item. You can stick with the default General cate-
gory or choose Create New Category to build your own system of categories.

6. Type a description of the building block in the Description box if desired.

7. Change the Save In setting if desired. The default is Building Blocks.dotx.

Figure 3.24
Create a new building
block and specify
which gallery it
belongs to.

T I P
The items in Building Blocks.dotx are available via the Building Blocks Organizer regard-
less of what template is in use.

8. Select the desired insertion method from the Options list:

■ Insert content only—Places the item at the insertion point.

■ Insert content in its own paragraph—Places the item in a separate paragraph.

■ Insert content in its own page—Places the item on a new page.

9. Click OK to create the new building block entry.

The new building block will now be available for insertion, as explained in the next section.

Inserting a Building Block
A building block’s insertion method depends on the gallery in which you placed it when you
created it. If you chose to place it in the Quick Parts gallery, it appears on the Quick Parts
list (see Figure 3.25).



If the desired building block does not appear in either location, you can select it from the
Building Blocks Organizer, as follows:

1. From the Insert tab, click Quick Parts and then click Building Blocks Organizer. The
Building Blocks Organizer dialog box appears.

2. Click an item to preview it (see Figure 3.26).

3. When you find the item you want to insert, click Insert.
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Figure 3.25
Building blocks appear
on different menus
depending on the
gallery in which they
were placed.

Figure 3.26
Insert an item from
the Building Blocks
Organizer.

N O T E
You might have some different building blocks than shown in Figure 3.26. If you
upgraded from an earlier version of Word, for example, you will have some of the
AutoText entries from the previous version available.
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Deleting Building Blocks
You can delete any building blocks, both those that you have created yourself and those
stored in the Building Blocks.dotx template that comes with Word. To delete a building
block, follow these steps:

1. From the Insert tab, choose Quick Parts, Building Blocks Organizer. The Building
Blocks Organizer dialog box appears.

2. Click the item to delete.

3. Click the Delete button.

4. When you are finished deleting blocks, click Close.

Changing a Building Block’s Properties
All of a building block’s properties are editable, including its gallery, its template location,
and so on. Follow these steps to edit building block properties:

1. From the Insert tab, choose Quick Parts, Building Blocks Organizer. The Building
Blocks Organizer dialog box appears.

2. Click the item and then click Edit Properties. The Modify Building Block dialog box
opens. It is much the same as the dialog box you used to create the building block ini-
tially (refer to Figure 3.24).

3. Make any changes as needed, and then click OK.

4. A confirmation box appears; click Yes.

Troubleshooting
I Don’t Want Word to Extend Selections

By default, Word uses smart paragraph selection. In other words, if you drag across a para-
graph to select it, Word will automatically include the hidden end-of-paragraph marker in
the selection area. This is for your own good, because it prevents you from leaving behind
the paragraphs’ marker inadvertently. Word also automatically selects an entire word when
you drag across selections, so your selection doesn’t stop in the middle of a word.

If you dislike either of these features, you can turn them off. Choose Office, Word Options,
click Advanced, and in the Editing Options section, clear the Use Smart Paragraph Selection
check box and/or the When Selecting, Automatically Select Entire Word check box.

I’d Like to Save Clipboard Content for Later Use

By far the easiest way to save something from the Clipboard is to paste it into Word (or
some other application) and then save it in that application’s native file format. But you can
also save, organize, and recall items from the Windows Clipboard.
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With a default installation of Office, a utility is installed called Microsoft Clip Organizer. 
It is primarily for managing clip art, but you can also use it to save items to and from the
Clipboard.

You’ll find it on the Start, All Programs, Microsoft Office, Microsoft Office Tools menu.
Start it up, and then choose Edit, Paste to copy the current contents of the Windows
Clipboard into the organizer. The pasted item appears as a thumbnail image there. You can
drag it into any of the various collections on the Collection List, assign keywords to it, place
it back on the Clipboard (with Edit, Copy), and more.

One thing you can’t do with the Microsoft Clip Organizer, however, is to save the clip as a
separate file. To do this, you need a different utility—the ClipBook Viewer. This is a
Windows XP utility, not Office. (It is not available in Windows Vista.) In Windows XP, you
can find it at this path: Windows\System32\clipbrd.exe. (Use the Run command to run it.) 

The ClipBook Viewer starts out with a single, minimized window called Clipboard that con-
tains the current contents of the Windows Clipboard. Restore this window and then choose
Office, Save As to save that clip as an NT Clipboard File (with a .clp extension). To recall 
a saved Clipboard item, use Office, Open. This places the content of the file onto the
Windows Clipboard, displacing what was there before.

The Building Blocks.dotx File is Corrupted

If you see a warning about the Building Blocks.dotx file being missing or corrupted, click
OK. If asked whether you want to recover the data from the file, choose No. Then close
Word, and use Windows to do a search for the file Building Blocks.dotx. Delete all instances
of that file and reopen Word. Word will re-generate a fresh copy of the file. You will lose
any building blocks you have created, however.




